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{ Project ]
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{ Module } { System }
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Pipe object Module
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1 TRIBON M2 Module

Module
2 System
18
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File>New )| Ctrl+N
=

Available projects on LOCATHOST
ElD Local projects
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ﬁ as Options |
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Cancel |
Module OK Module
Module
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Module Delete
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Module Module
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€ System

1 System

Pipe systems New System

New System x|
Swstem Name:
" cmea |

Surface Preparation Code:
I—l

System

System Name------------------- :

Surface Preparation Code-----:
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2 System
System Delete

System
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TRIBON M2
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TRIBON M2

DAT

SB_INPUT1 sx001

IDENT
IDENT[ <id>] /PROJECT=<projid>

[ <id>] <id>

<projid>

REFERENCE

1 REF/XTAB=<hull table name>
<hull table name> X

= **XTAB = **

2 REF/YTAB=<hull table name>

<hull table name> Y

< **YTAB = **
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REF/ZTAB=<hull table name>
<hull table name>

< **ZTAB = **

REF <refid> /X=<coordinate>

<refid>

<coordinate> X
X
REF <refid> /Y=<coordinate>

<refid>

<coordinate> Y
Y
REF <refid> /Z=<coordinate>

<refid>

<coordinate> Z
Z
REF <refid> /PANEL=<panelname>

<refid>

11
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<panelname> PANEL 26

PANEL

IDENT <JB */PROJECT=<ES~

REF < DECK1 *”/PANEL= “ ES123-1SP *
REF = DECK2 */Z2=20000

REF/XTAB=“ ESXTAB *
REF/YTAB=“ESYTAB ~

REF/ZTAB= < ESZTAB ~

> sx001
modcoord.dat D
modcoord.Ist D
1
2 > > >
3 tbsetenv SB_LIST1 D:\ modcoord.Ist
4 tbsetenv  SB_INPUT1 D:\ modcoord.dat
5 sx001
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>

1 DRAFTING
2

File>New [ CV6
3

Insert-> Model =
4 =

File->Save =
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PLACED VOLUME
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Insert-> Model

;

CLCCEE

"1
i

I T T T I Y Y i’i’

VIEW

[ E—

New-------:
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Single-----

Multiple--:

Existing--:
Side----------

Peoccccmeee

= J—

[P —
Name--------

cexs> cc 33
Module------ ;
MODULE CExTE e 77
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Name  Module

Name  Module
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Use Box----- :

Def. box---:

Indicate----:

Incl. All----- :

Excl. All----:
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> —->TRIBON M2->Outfitting—>Pipe Modelling

Kev in user i1dentification:

| I

T B Options Cancel guit |
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2 component menu
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>

[T

File=>Open List

Open

Pipe—>Ident-> Update
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Uzer identification...: LES/MfZ525

I i

| oc Tt i Cancel | Quit |

OK

Froject name. ... ... ... E3

| =

k| or e Cancel | Quit |

Cancel

OK

Module mame. ... ...... ! Dot set

| I

ok | or [— Cancel |  guit |

Cancel

Drawing name. ... ... ... naot set

I =

k| or e oL guit |

Cancel
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OK

Flanning unit.. ... ... not set
| =
k| or e oL guit |
Cancel OK
>

Pipe—>Ident-> Display
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IDENT informatien
User identification...: LES/M/2525
Froject name. ........: E3
Module name..........: neot set
Drawing name.......... not set
Flamming unit........: not =et

Tes
>
Pipe>New

pipe x|
Pipe name: I j

Component name: I

secification -:| Component dbl

clow: [ |

Pipe name( )
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XX-XXXX-XXXXXX
Pipe name( ) j
Component name
Specification PIPE SPECIFICATION
Component db GCDB
Diagram
Colour
OK
Current is XX-XXXX-XXXXXX.! XX-XXXX-XXXXXX
>
Pipe—>Activate &
YES NO
Indicate pipe
k]
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Kew in name of pipe:

| =

k| oc | options | Camca guit |

OK

Current is XX-XXXX-XXXXXX.! XX-XXXK-XKXXXX

Fhhhhhkhkhkkkhkhkhrrhhhkhkhkkhkhkhrrrhrhhkhhdhhrrrrhhhkhhhhrrrrhhhhhhhiirriiiikhhiikx
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>

Pipe—>Save &
XX-XXXX-XXXXXX stored in the data bank.! XX-XXXXK-XXXXXX
>

Pipe—>Cancel &

0K to cancel current pipe object ES-ECS-ERZ 7%

Ho | [ptions | Cancel I Bt I

YES NO YES NO
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Pipe—>Delete X

YES NO

Indicate pipe to be deleted

Gy

Eey in name of pipe to be deleted:

I =

k| oc | optiens | Cancel guit |

OK
YES
The pipe XX-XXXX-XXXXXX has been deleted from data bank.!

XXK-XXXK-XKXXKX

>

Pipe—>List activated
Current is XX-XXXX-XXXXXX.! XX-XXXX-XXXXXX
>

Pipe Model->Route ol

Options mean On surface of part or External connection or Free point!

Options

25 25
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Indicate part

Indicate connection

R
e

Cancel steps back. Option means connect to part selected!

Cancel Option

Cursor position

2Db 3D
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Options

Start route
lptions |

External conmection | Cancal |

Free point | Gurt |

[ |2

On surface of part

On surface connection wanted.!

Options mean On surface of part or External connection or Free point!
Options

Indicate part

Cursor position

2D 3D

27
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28

Pipe Modelling (

Cancel steps back. Option means connect to part selected!

Cancel

Cursor position

Options

Start route

External conmection | Cancal

i lptions |

2
3

Free point | Gurt

External connection

External connection wanted.!

( )

Options mean On surface of part or External connection or Free point!

Options

Indicate part

Indicated is pipe XX-XXXX-XXXX,
component F13-6-125, id 4!

Indicate connection

28

Option

2D

XX-XXXK-XXXX

3D
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29

Pipe Modelling ( )

3D

Options

Start route
lptions |

2 External conmection | Cancal |
3  Free point | Gurt |
Free point

Cancel steps back. Option means connect to part selected!

Cancel Option

Cursor position

2D 3D

29
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2D
2D 3D
2D
3D

TRIBON M2 2D
s |

MNBEBANK S QG2 | & s

IT Cursor Position

\ Node Point

Key in( )

&) Event point( )

™\ Midpoint( )

X Intersection( )

™ Nearest point( )
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= Existing point( )

© Arc Centre( )

& Arc by Angle( |

—* Distance Along Contour(

] Centre of Gravity( )
D% Symbol Connection( )

Symbol

" Offset current( )

/* Automatic( )

"% Add Offset( )

2D
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B | ock U( )
2D
2D
I8 | ock V( )
2D
2D
> 3D
TRIBON M2 3D
A

E ]| @ e | dodoFalal o D /ada| |60 e 2

Keyin( )
& Event point( )
"% Offset current( )
8 Lock U( )
2D
2D
18 | ock v )
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2D
2D
8 | ock View( )
2D
Lilock X( X )
X
2D
b LockY( Y )
Y
2D
“ lockz(  Z )
Z
2D
& | ock Event Plane( )
2D

& LockXZ(  XZ )

Xz
Y 2D

@ LockYZ(  YZ )
YZ
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X 2D

L Lockxy( xY )

XY
Z 2D
/8 | ock Event Line( )
4a -
Lock Any Lineg( )

C§

Unlock( )
[

Set Current( )
& Add Offset( )
P Verify( )

34 34
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3D Point Definition - ¥erify

0E?

Ho I Options I Cancel | fuit

YES NO

(route)

Pipe Model->Material->Frame to pipe

Indicate branch

Pipe Material

Select bend

1 B o |  options |
2 Sams as |  camear |
5 Bompemat @ | guit |
9 SooclEhelen |
5 [ Sl |
6 Joint |
H  [Hoos commoetien |

35 35
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Specification

1  Eey in

2  Same as

3 Component db

4 Specification I
Specification

g Bend T TTEEsETE

36
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Pipe Material

Select straight

1 B b |  options |
2 S e | cancer |
5 B 0 | guit |
4 SooedEenlen |
5 e e |
- |

T Fipe o 14-E- 15

Indicate branch

Pipe Model->Material->Subst straight

Indicate part( )

Pipe Material

Select straight

1 B b |  options |
2 S e | cancer |
5 B 0 | guit |
4 SooedEenlen |
5 e e |
- |

T Fipe o 14-E- 15

37
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Indicate part( )

R R R R R R R R R S R R R R R R R R R R R R R R R R R R R A R R R R R R R R R R R R R R R R R R R R R R R S R R R R R R R R e e e

Fhhhhhkhkhkkkhkhkhrrhhhhkhkhkkhkhhrrrhhrhhkhkhhhrrrrrhhkhkhhhrrrrhhhhhhhiirriiiikhhiix

Pipe Model->Material-> Subst bend e

Indicate part( )

Select bhend

1 Eey in | lptions |
2 Same as | Cancel |
3 Component db | Guit |
4 Specification |

5 e e |

5 Jwan |

T Boss commection |

g Bend : 1147571203 i

Indicate part( )
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[l

Pipe Model->Remove material->Pipe to frame

Ok to replace pipe by frame?

Ho | ptions | Cancal | Ozt |

YES NO

Pipe Model->Remove material>Branch to frame
A7

Indicate branch

Ok to replace pipe by frame?

Ho | ptions | Cancal | Ozt |

YES NO

39
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Indicate branch

Pipe Model->Part->Add <

Options mean On surface of part or External connection!
Gk
(

Indicate part

ThSpecSearch x|

& Specification ¢ ES ) not found,

40
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41

Pipe Modelling ( )
x|

—Selaction criteria

Specification

Project mame: [po j

Spec. name: 3

Change |
Function (short Function type
[+ main fitting I j I—— all t}-pesll
[ with flangel I j
[T with gasket( I j
Hominal |3|:|
f;ut am ation ILD“. ;I
Options

Specification_Project name---

[

Specification_Spec. name-----

[

main fitting_Function(short)-
main fitting Function type---
with flange_Function(short)--

with gasket Function(short)--

[

41

Specification

Specification
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Nominal------ :

Automation---:

Low ’

Medium

High

Change |

Options |

Cancal

B R R T R R R S R R S R R S R R S R R S R R S R R R R R T S R T R R P R R R R R R R R R S R R S R R R R R R R R S R R S P R S S R T S

Do6

SB_PIPE_SPECDRIVEN NO YES ALWAYS

NO
YES

ALWAYS

42 42
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SB_PIPE_SPECDRIVEN NO
SB_PIPE_SPECDRIVEN YES
SB_PIPE_SPECDRIVEN NO

B R R T R R R S R R S R R S R R S R R S R R S R R R R R T S R T R R P R R R R R R R R R R R R S R R R R R R R R S R R S P R S S R T S

Options

Pipe Material

Select component

l H fo |  options |
2 Same as | comear |
9 Compument @ | guit |
4 Sl Eealen |
5 DI s |
B Joint |
0 oo emmoetin |

[4u]

Bend : 114-5-1203 |

5 With flange
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&  Joint

Choose joinkt

4 Insert jeimt Uptions |

2 Mitre joint | Cancal |
5 Threed Jolnd | guit |
0 elld Jusad |

i Inzert joint _I

2 e el |

3 T jodut |

9 el o |

Options mean On surface of part or External connection!
)
(

Indicate part

Fhhhhhkhkhkkkhkhkhrrhhhhkhkhkkhkhkhrrrhhrhhkhkhhkhrrrrhhrhkhkhhhrrrrirhhhhhhiirriiiikhhiix

SB_PIPE_SPECDRIVEN NO
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Fhhhhhkhkhkkkhkhkhrrhhhhkhkhkkhkhhrrrhhrhhkhkhhhrrrrrhhkhkhhhrrrrhhhhhhhiirriiiikhhiix

Pipe Model>Part->Add &
Options mean On surface of part or External connection!
( m

Indicate part

Pipe Material

Select component

i B o |  options |
2 S e | canca |
5 Coeman 0 | it |
9 GodiEheien |
5 e e |
5 Jwan |
- |

& Fipe . 114-ECTES

|[u}

Fend : 114-5-1203 |

Direction missing!

45 45



TRIBON M2
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Additional information
Choose modification
lptions |

Direction | Cancal |

Gurt |

2

Direction

Ir-2

Cursor position

3D

Options mean On surface of part or External connection!
)
(

Indicate part

Pipe Model>Part->Add &
Options mean On surface of part or External connection!
( m

Indicate part
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Pipe Modelling ( )

Pipe Material

Select component

i B o |  options |
2 S e | canca |
5 Coeman 0 | it |
9 GodiEheien |
5 e e |
5 Jwan |
- |

& Fipe . 114-ECTES

|[u}

Fend : 114-5-1203 |

Cut off the building length (Yes or Hol?

Ho | [ptions | Cancel | Bt

Yes No

Orientation missing!

Option means select direction!

Cursor position

2D

47
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Additional information

Select direction

5z
B -

Options mean On surface of part or External connection!
)
(

Indicate part

x
>
Pipe Model->Part->Add <
Options mean On surface of part or External connection!
(= )

Indicate part

Gy

48 48
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Start route

lptions |

2 External conmection | Cancal |

Gurt |

|ﬂ On surface of part :

Options mean On surface of part or External connection!
)
(

Indicate part

Pipe Material

Select component

1 Eey in | ostions |
5 Same as | cancer |
3 Component db | guit |
4 Specification |
5 D e |
B Joint |
H  Hoos commoetien |

8 ¥ipe o TT4FESTEHE

[u]

Fend © 114-5-1203 |

o
)

49 49
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Options mean On surface of part or External connection!
)
(

Indicate part

Pipe Model->Part->Add <
Options mean On surface of part or External connection!
( Gk

Indicate part

Gy

Start route

lptions |

2  External conmection | Cancel |

Guit |

2  External conmectiom |

Options mean On surface of part or External connection!

( Lt

50 50
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Indicate part

Select component

1 Eey in | lptions |
2 Same as | Cancel |
3 Component db | Guit |
4 Specification |

5 e e |

5 Jwan |

T Boss commection |

8 Pipe | 11451203

9 Bend : 114-5-1203 |

Options mean On surface of part or External connection!
)
(

Indicate part

Pipe Model->Part->Delete X

Indicate part( )
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Delete Parts

Delete Parts

lptions |

Beplace by Frame | Cancal |

?
5 Dellote | guit |

2  Replace by Frame
3  Delete
Indicate part( )

Pipe Model->Part->Insert

Indicate part(

52 52
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Pipe Modelling ( )

Select component

1 Eey in | lptions |
2 Same as | Cancel |
3 Component db | Guit |
4 Specification |

5 e e |

5 Jwan |

T Boss commection |

8 Pipe | 11451203

9 Bend : 114-5-1203 |

5  With flange

Cursor position

3D 2D
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Indicate part( )

Pipe Model->Part->Flip

Indicate part( )

0K to continue (Yes or Hol?

Yes

No Yes

Pipe Model->Part->Rotate

54 54
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Indicate part( )

Indicate connection

L

Indicate connection

Key in angle [rotate]:

[
ok | o | options Cancel

Buit

OK

Pipe Model->Part->Rotate

Indicate part( )

Indicate connection

Cursor position

a4

3D Offset current
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3D Point Definition - Offset from Current
Key in offset [d1):

0K I Options Cancel

guit |
OK
3D Point Definition - Offset from Current
Kew in offset (dx, dy, dz):
[ i
0K I Options Cancel Quit I

OK

Pipe Model->Part->Rotate

Indicate part( )

Indicate connection

Cursor position

3D & Offset current

3D Point Definition - Offset from Current

Key in offset [d1):

0K I Options Cancel

guit |

OK
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Pipe Modelling ( )

3D Point Definition - Offset from Current

Kew in offset (dx, dy, dz):
[ [
0K I Options Cancel Quit I

OK

Pipe Model->Part->Split

Indicate part( )

Cursor position

3b 2D
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Pipe Modelling ( )

DK to continme (Yes or Ho)7

Yes No

Indicate part( )

>
1
Pipe Model->Part->Info
Indicate part( )
Indicate part( )
v
2

Pipe Model->Part->Info

Indicate part( )

Gy
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59

Pipe Modelling ( )

External part requested

Indicate part( )
Indicate part( )
X
v
Pipe Model->Group->Transform
Indicate part < free group >( < >)

Option means to key in delta value!

3D point: event
Indicate event point

2D 3D
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Pipe Modelling ( )

0E to continue (Yes or Hol?

Ho | [ptions | Cancel | Bt

Yes

No ,

Option means to key in delta value!

3D point: event

Indicate event point

Pipe Model->Group-> Transform

Indicate part < free group >( < >)

Option means to key in delta value!

3D point: event

Indicate event point

L

Select model part

60
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61

Pipe Modelling ( )
Indicate event point
Indicate event point
2D 3D

0E to continue (Yes or Hol?

Ho | [ptions | Cancel | Bt

No ,
Option means to key in delta value!
3D point: event

Indicate event point

Pipe Model->Group-> Transform

Indicate part < free group >( < >)

Option means to key in delta value!

3D point: event
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Kew in dx, dy, dz:

I =

k| or Options | Cancel |  guit |

OK

0E to continue (Yes or Hol?

Ho | [ptions | Cancel | Bt

Yes

No ,

Option means to key in delta value!

3D point: event

Indicate event point
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Pipe Modelling (

Pipe Model->Group-> Rotate

Indicate part < start of rotation >(

>)

Indicate connection( )

Indicate part < end of rotation >(

>)

Indicate connection( )

Indicate part < to direct >(

>)

Indicate connection( )
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Pipe Modelling ( )
FIRAT JEGAND IHD
GONN GONN LINE
Choose rotation axis
FIRST CONN
SECOND CONN
IND LINE
g

Option means to key in delta value!
Cursor position

fa7n
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Pipe Modelling ( )

Few in rotation angle:

I _ [
x| oo | optiens oL guit |
OK
guestion
O to contimme (Yes or Hol?
Ho | Options | Camesl | guit
Yes
No
Indicate part < start of rotation >( <
>)
x 0 v
2
Pipe Model->Group->Rotate
Indicate part < start of rotation >( <
>)
]
Indicate part < to direct >( <
>)
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Pipe Modelling ( )

Indicate connection( )

Choose option

1HD
LINE

IND LINE

Option means to key in delta value!
Cursor position

fa7n

Few in rotation angle:

I =

k| oo | optiens oL guit |
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67

Pipe Modelling ( )

0E to continue (Yes or Hol?

Ha | [ptions I Cancel I Guit

Yes

No
Indicate part < start of rotation >( <

>)
)
Pipe Model->Group—~>Add to conn

Indicate part < group > < >
Indicate connection( )

Options mean On surface of part or External connection!
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68

Pipe Modelling ( )
L
Indicate part < add to > <
Indicate connection( )

0E to continue (Yes or Hol?

Ha | [ptions I Cancel I Guit
Yes
No
Indicate part < group > < >
Pipe Model->Group->Add to conn
Indicate part < group > < >
Indicate connection( )

Options mean On surface of part or External connection!

L

Indicate part < add to > <
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69

Pipe Modelling ( )

L

Start route

[lptions |

2 External comnmection | Cancal |

Gz t |

2 External conmection |

External connection wanted.!

Options mean On surface of part or External connection!

L

Indicate part < add to > <

Indicate connection( )

0E to continue (Yes or Hol?

Ha | [ptions I Cancel I Guit
Yes
No
Indicate part < group > < >
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70

Pipe Modelling ( )

Pipe Model->Group->Change length

Indicate part < length change > <

Indicate connection( )

Option means to indicate free, absolute or delta value!

L

Cursor position

2D

Pipe Model->Group->Change length

70
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Pipe Modelling ( )

Indicate part < length change > < >

Indicate connection( )

L
e

Option means to indicate free, absolute or delta value!

L

Cursor position

L

Optional definition of length
Define by
lptions |

2  Absolute length | Cancel |
S e Ll | guit |
|§1 Free point _I

Cursor position

2D 3D
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Pipe Modelling ( )

Pipe Model->Group->Change length

Indicate part < length change > <

Indicate connection( )

Option means to indicate free, absolute or delta value!

L

Cursor position

L

Optional definition of length
Define by
lptions |

fbzolute length | Cancel |

[ ]

Delta length | Gu1t |

2  Abzolute length |

72 72
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e
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Pipe Modelling ( )

Kew in length:

I I~
k| oc | options | Camca guit |
OK
D
Pipe Model->Group—>Change length
Indicate part < length change > < >
Indicate connection( )

73

Option means to indicate free, absolute or delta value!

L

Cursor position

L

73
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Pipe Modelling ( )

Optional definition of length
Define by
lptions |

fbzolute length | Cancel |

2
S e Ll | guit |

3 Delta length |

Kew in length change:

| I~
k| oo | options | guit |
OK
2
 ——
i l
A
Pipe Model->Group->Change length
Indicate part < length change > < >
Indicate connection( )
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75

Pipe Modelling ( )

Indicate part < length adjusting > <

Option means to indicate free, absolute or delta value!

L

Cursor position

2D

DK to continme [(Yes or Ho)7

Yes

75
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76

Pipe Modelling ( )

No
Indicate part < length change > <

v

Pipe Model->Group->Change length

Indicate part < length change > <
Indicate connection( )
Indicate part < length adjusting > <

Option means to indicate free, absolute or delta value!

L

Cursor position

L
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77

Pipe Modelling ( )

Optional definition of length
Define by
lptions |

2  Absolute length | Cancel |
S e Ll | guit |
|§1 Free point _I

Cursor position

2D 3D

DK to continme [(Yes or Ho)7

Ho | ptions | Cancal | Ozt
Yes
No
Indicate part < length change > <
v
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Pipe Modelling ( )

Pipe Model->Group->Change length

Indicate part < length change > <

Indicate connection( )

Indicate part < length adjusting > <

Option means to indicate free, absolute or delta value!

L

Cursor position

L

Optional definition of length
Define by
lptions |

fbzolute length | Cancel |

£
3

Delta length | Gu1t |

2  Abzolute length |
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Pipe Modelling ( )

Kew in length:

I =
k| or Options | Cancel |  guit |
OK
0 to continue (Yes or Hol?
Ho | ptions | Cancal | Ozt |
Yes
No
Indicate part < length change > < >

> (W

v

Pipe Model->Group->Change length
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Pipe Modelling ( )

Indicate part < length change > <

Indicate connection( )

Indicate part < length adjusting > <

Option means to indicate free, absolute or delta value!

L

Cursor position

L

Optional definition of length
Define by
lptions |

fbzolute length | Cancel |

£
3

Delta length | Gu1t |

3 Delta length |
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Pipe Modelling ( )

Kew in length change:

| =

k| or Options | Cancel |  guit |

OK

DK to continme [(Yes or Ho)7

No | ostions | Cameel | guit |
Yes
No
Indicate part < length change > < >
x
v

Fhhhhhkhkhkkkhkhkhrrhhhkhkhkkhkhkhrrrhrhhkhkhhhrrrrhhrhkhkhhhrrrrhidhhhhhiirriiiikhhiikx
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Pipe Modelling ( )

Indicate part < length adjusting > < >

e

Fhhhhhkhkhkkkhkhkhrrhhhhkhkhkkhkhhrrrhhrhrhkhhhhrrrhirhrhkhhhhhrrrhhhhhhhiirrhiihhhiikx

Pipe Model->Group—->Rename

Indicated pipe to fetch from

0E to continme (Yes or Hol?

Ho | [ptions | Cancel | Bt |

No

Indicated pipe to fetch from

Yes

Indicate part < dividing limit > < >
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83

Pipe Modelling ( )

v

Indicate part < group to transfer > <

DK to continme [(Yes or Ho)7

Ho | ptions | Cancal | Ozt
No
Yes
0K to store current pipe object ES-ECS-EQI
in the data bank (Tes or Ho)?
Ho | [ptions | Cancel | Bt

No

Yes

Pipe Model->Group—>Rename

Indicated pipe to fetch from

DK to continme [(Yes or Ho)7

No

Indicated pipe to fetch from
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Pipe Modelling ( )
Yes
Indicate part < dividing limit > < >
Indicate connection( )
Indicate part < dividing limit > < >
Indicate part < group to transfer > <

DK to continme [(Yes or Ho)7

No

Yes

0K to store current pipe object ES-ECS-EQI
in the data bank (Tes or Ho)?

Ho | [ptions | Cancel | Bt
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85

Pipe Modelling ( )

Yes

Pipe Model->Group—>Rename

Indicated pipe to fetch from

DK to continme [(Yes or Ho)7

No

Indicated pipe to fetch from

Yes
Indicate part < dividing limit > < >
L
Indicate part < divide > < >
o
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Pipe Modelling ( )

Cursor position

2D

£

DK to continme [(Yes or Ho)7

Ho | ptions | Cancal | Ozt
No
Cursor position
Yes
Indicate part < dividing limit > < >
Indicate part < group to transfer > <
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Pipe Modelling ( )

DK to continme [(Yes or Ho)7

No

Yes

0K to store current pipe object ES-ECS-EQI
in the data bank (Tes or Ho)?

Ho | [ptions | Cancel | Bt

No

Yes

Pipe Model->Connect

Options mean On surface of part or External connection!
Gk
(

Indicate first part

Indicate connection( )

Options mean On surface of part or External connection!
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88

Pipe Modelling ( )

( = )

Indicate second part

Indicate connection( )

Options mean On surface of part or External connection!
)
( )

Indicate first part

Pipe Model->Connect

Options mean On surface of part or External connection!
)
( )

Indicate first part

Indicate connection( )

Options mean On surface of part or External connection!
)

( )

Indicate second part

L

88
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Pipe Modelling ( )

Start route
lptions |

2 External conmection | Cancal |

Gurt |

|ﬂ On =urface of part ﬂ

On surface connection wanted.!

Options mean On surface of part or External connection!
L]

( )

Indicate second part

Options mean On surface of part or External connection!

( = )

Indicate first part

x 0

Fhhhhhkhkhkkkhkhkhhrhhhkhkhkkhkhkhrrrhirhrhkhhhhrrrrirhrhhhhhirrrhhhhhhhihirriiiihhiix

Fhhhhhkhkhkkkhkhkhrrhhhkhkhkkhkhkhrrrhirhhkhhhhrrrrirdhkhhhhirrrhidhhhhhiirrhiiihhiix

Pipe Model-> Connect
Options mean On surface of part or External connection!
)
( )
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90

Pipe Modelling ( )

Indicate first part
Indicate connection( )

Options mean On surface of part or External connection!
)

( )

Indicate second part

L

Start route
lptions |

2 External conmection | Cancal |

Gurt |

2 External conmection |

External connection wanted.!

Options mean On surface of part or External connection!
)
( )

Indicate second part

Indicate connection( )

Options mean On surface of part or External connection!
)

( )

Indicate first part

90
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Pipe Modelling ( )

>

Pipe Model->Disconnect
Indicate part( )
Indicate connection( )

0E to continme (Yes or Hol?

Ho | [ptions | Cancel | Bt
No
Indicate part( )
Yes
Indicate part( )
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Pipe Modelling (

>

Pipe Model->Boss connect
Indicate part( )
Indicate connection( )

Choose way of connecting boss / bra

i On =surface [ptions |

2 s |  cancer |
9 Bl | guit |
0 Sl |
5 Do |

i1 On surface

2 Insert |
3 Extrude |
4  Saddle

5 Hone
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Pipe Modelling ( )

Pipe—>Colour

OK

Pipe>Change user id

Current user ID (XXXX)! XXXX

Hew user IN:

| =l

ok | oo | optiems Cancel guit |

> PRG
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Pipe Modelling ( )
PRG
Pipe->Regenerate PRG
PRG
< >< >< >.PRG
PRG SB_PIPESCH
D065
RES
RES
Pipe—>List RES
RES
< >< >< > RES
RES SB _PIPEPRINT
D065

Pipe—>Pipe group—>Move
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Pipe Modelling ( )

Indicate pipe to include

Indicate pipe to include

Indicate pipe /view to be trans- reference or OC when ready

Choose transformation or pick item to drag

Indicate pipe /view to be trans- reference or OC when ready

v

Indicate pipe to include

Pipe—>Pipe group—>Move
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96

Pipe Modelling (
Indicate pipe to include

L

i Model Selection

—oelection criteria

Froject: IES

Hame: I ﬂndule:l

Essembly:l

Uze Bg}{ir Use Eolygon:ids Uze Eectangled”

Include I Exclude | ndicate Im:I ndicate Exr:I

—List of selected models

E” Hame I Module

Ho model =zelacted.

Include-----------

Exclude----------
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Pipe Modelling ( )

Indicate Inc.----

Indicate Exc-----

B R R R R R R R S S R R R R R R R R R R S R R R R R R R AR R R R R R R R R R R R R R R R R R R R R AR R R R R R R R R e S e

INCLUDE EXCLUDE

INCLUDE EXCLUDE

Fhhhhhkhkhkkkhkhkhrrhhhkhkhkkhkhkhrrrhrhhkhkhdhhrrrrirhhkhkhhhrrrrhihhhhhiirriiiikhhiix

Module----------

Ok

Indicate pipe /view to be trans- reference or OC when ready
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Pipe Modelling ( )

Choose transformation or pick item to drag

Indicate pipe /view to be trans- reference or OC when ready

v

Indicate pipe to include

Pipe—>Pipe group—>Move parts

Draw window for part selection. Option means draw polygon-window for part

selection( G

)

Cursor position( )
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Pipe Modelling ( )

|:
]
|
]
]

Give distance to move. Option means indicate free point or absolute length(
L
)

Cursor position( )

2D 3D

2D 3D =
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Pipe Modelling ( )

Confirm move parks

I= the mowe operation correct?

Ho | [ptions I Cancel I Bt

Yes

Draw window for part selection. Option means draw polygon-window for

part selection( o

Cursor position( )

L

Optional definition of length
Define by
lptions |

2  Absolute length | Cancal |

Gurt |

Define first point

Cursor position

Define second point

Cursor position
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Pipe Modelling ( )

D 3D

Confirm move parks

I= the mowe operation correct?

Ho | [ptions I Cancel I Bt

Yes

Draw window for part selection. Option means draw polygon-window for

part selection( o

Cursor position( )

o ( )

Optional definition of length

Define by

lptions |

2  Absolute length | Cancal |

Gurt |

E pbsolute length

Indicate part connected to selected part(s)
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Pipe Modelling ( )

Kew in length:

I =

k| oc | options | Camca guit |

OK

Confirm move parks

I= the mowe operation correct?

Ho | [ptions I Cancel I Bt

Yes

Draw window for part selection. Option means draw polygon-window for

part selection( o

)
Cursor position( )
x ™ v

Pipe—>Pipe group—>Duplicate
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Pipe Modelling ( )

Indicate pipe to include

Indicate pipe to include

i Model New Name x|

—List of selected models

[ | 014 Hame | Hew Hame | 014 Module | Hew Module |
WHS4 WS4 KCS KOS
WHSS W55 Ko ane
WHSE HHSE ECS ECS

3 of 3 models selected. Hew Module | [W¥elect 811

Indicate | Cancel |

&

Old Name ---------

New Name --------

Old module--------

New module-------

Select All------------
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Pipe Modelling ( )

Cancel--------------

B R R T R R R S R R S R R S R R S R R S R R S R R R R R S S R T R R R R R R R R R R R R S R R S R R R R R R R R S R R S P R S S R T S o

B R R R R R R S R R S R R R R R R R R e R R S R R S R R T S R T R R P R R R R R R R R R R R R S R R R R R R R R S R R S P R S S R T S

OK

Indicate pipe /view to be trans- reference or OC when ready

Choose transformation or pick item to drag

Indicate pipe /view to be trans- reference or OC when ready
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Pipe Modelling ( )

Cancel

Pipe—>Pipe group—~>Duplicate
Indicate pipe to include
]

OK

OK

Indicate pipe /view to be trans- reference or OC when ready

Choose transformation or pick item to drag

Indicate pipe /view to be trans- reference or OC when ready
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106

Pipe Modelling ( )

QUIT

Pipe—>Pipe group—>Rename

Indicate pipe to include

Indicate pipe to include

ocC
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Pipe Modelling ( )

x
Spools totally outzide box are excluded
Box X-min: || Box ¥—max: I
T-min: I T-max: I
Z-min: I Z-max: I
THDICATE THCL | THDICATE EOX | DISFLAY SELECTION | QUIT |
INDICATE EXCL | RESET SELECTION | HEW NANES | o |
Box X-min---: X
Box Y-min---: Y
Box Z-min---: Z
Box X-max---: X
Box Y-max---: Y
Box Z-max---: Z

B R R R R R R R S S R R R R R R R R R R R R R R R R R R AR R R R R R S R R R R R R R R R R R R R R AR R R R R R R R R R R e T e

Fhhhhhkhkkkkhkhkhrrhhhkhkhkhkhkhhrrrhirhhkhhhhrrrrhirhdhkhkhdhkhrrrrhihhhhhiirriiiihhiix

INDICATE INCL--------

INDICATE EXCL-------
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Pipe Modelling ( )

INDICATE BOX----------

RESET SELECTION----

DISPLAY SELECTION-

ocC

Indicate pipe to include

Pipe—>Pipe group—> Rename

Indicate pipe to include
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Pipe Modelling (

Indicate pipe to include

Pipe—>Pipe group—>Colour

Indicate pipe to include

Indicate pipe to include

109

OK

OK

oC
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110

Pipe Modelling ( )

,  OK
Indicate pipe to include
™
Pipe—>Pipe group->Colour
Indicate pipe to include
]
,  OK

Indicate pipe to include

110
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Pipe Modelling ( )

Pipe—>Pipe group—->Delete

Indicate pipe to include

Indicate pipe to include

v
0K to delete selected pipes?
Ho | [ptions | Cancel | Bt
Yes
Indicate pipe to include
v
Pipe—>Pipe group—->Delete
Indicate pipe to include
{n
OoC
0K to delete selected pipes?
Ho | [ptions | Cancel | Bt
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Pipe Modelling ( )

Yes

Indicate pipe to include

> PRG

PRG

Pipe—>Pipe group—>Regenerate

Eey in input file name for batch modelling

| =l

0k | oc Taioms — guit |

DAT
PRG
DAT
OK
Indicate pipe to include

PRG

Indicate pipe to include

PRG v
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Pipe Modelling ( )

PRG

Fey in input file name for bateh modelling

| =
ok | o | optiens | cancel | guir |
PRG Cancel Quit
2
Pipe—>Pipe group—>Regenerate
Enterstring
Fey in input file name for bateh modelling
| =
ok | ar Optiens — guit |
DAT
PRG
DAT
OK
Indicate pipe to include
L
PRG OK

PRG
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Pipe Modelling ( )

Fey in input file name for bateh modelling

| i

ok | o | optiens | cancel | guir |

PRG Cancel  Quit

Pipe>Component menu

Component menu

Handle menu

d  Set component name ! Uptions |

2  Reaszet | Cancel |
3 Display memm | Guit |
S el Gl |

il Set component name

2  Razet |

3  Diszplay menm |

9 ged Cafaily |
1

|§1 Set component name
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Pipe Modelling ( )

Choose option

— f [I] [::I DD<] _ I e IH WITH
FLANGE
SANE JaInT
hE
Ba3s
GONN

BENDOOBJ SPEE
Ip

GarF
o]

HEw'

NEW

Indicate position

Choose option

— | | 1 ||
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Pipe Modelling (

)

|-

[><]

-
|

Kew in name of component:

Options

Canecel

Gait

116

OK

Rezat

116
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Pipe Modelling ( )

TRIBON M2

Pipe Admin->Display unconnected

These ends are not connected

Pipe Admin->Remaining->Pipe
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Pipe Modelling ( )

Few in name of =y=stem:

I I~
k| or Options | Cancel |  guit |
OK
Remaining pipes:
XXX XXX
No remaining pipe
2
Pipe Admin->Remaining->Valve
Enterstring
Few in name of =y=stem:
I I~

k| or Options | Cancel |  guit |

OK

Remaining valves:

VXXX, VXXX
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Pipe Modelling ( )

No remaining valve

Pipe Admin—>Remaining—>Connection

Hame of general diagram (wildeards allowed):

0K I ac Options Canecel

Gait

Remaining connections:

XX-XXX

No remaining connections.

Pipe Admin—>Pressure drop

Indicate part( )

Indicate part( )

119 119
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Pipe Modelling ( )

Kew in the cwrrent flowrate:

[ =l
ok | or Options | Cancel | guit |
m3/h OK
Kew in the flowchange + / -1
| =l
k| Options Cancel guit |

OK

Total pressure drop : XXX mwc. XXX mwc.

Y

Pipe Admin—>Object check

Fipe object check (Yes or Hol?

Ho | (ptions | Cancel | Guit |

Yes

No

120 120




TRIBON M2

Pipe Modelling ( )
<
YES
I

NO

Tools>Model->Collision Control...
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Pipe Modelling (

Collision control

Collisions between

1 Indicated models | Options |
£ TIndicated models and wi Cancel |

[a)

Restrict on model typesl Quit |

1l Indicated models

[520
-
=]
P
-
n
w
-+
i
=
3
o
L
i
=
11
e
3

| [d3]

Restrict on model types

| [d3]

Restrict on model types
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Pipe Modelling ( )

Interference Check Filter

Pipe panel Pipe  panel



TRIBON M2

Pipe Modelling ( )
| 1]:4

1l Indicated models

Select model part

Choose level

2 1 VIEW

Select model part

Collision control

Result
Options |

Cancel I

2 Highlight all

4 List on file

|

3 Highlight one by one | guit |
|
|

5  Zet none shaded mode

i Tist |
€ Highlight 211 |
3 Highlight one by one

|

Lizt on file
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Pipe Modelling (

S  Set none shaded mode
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Pipe Modelling ( )

1 Pipe information( )

Pipe Production—->Pipe info->Update

Pipe information

r
r
—

bo ot chenge =]
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Pipe Modelling ( )
Sketch note---------- :
TRIBON
Sketch note
Component------------ :
Drawing name--------- :
Drawing name
TRIBON
Drawing name
Cost code------------ :
Data Management
Joint code----------- :

Planning unit-------—- :
Planning unrt
GCS

Weld code------------ :
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TRIBON M2

Pipe Modelling ( )
Heat treatm---------- :
Surf treatm---------- :

Initiate Outfitting( ) Pipe surface treatment

TRIBON
Bending rad---------- :
Test press----------- :
Insulation comp------ :
Default insulation---:
Exit

Pipe Production->Pipe info->Update
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Pipe Modelling ( )

1 POS AUT UPDATE

SBP_MODEL_DEF
SBP_MODEL_DEF D06
A POSNAME_SEQUENCE = <position name definition file>

POS AUT UPDATE

<position name definition file>
SB_PIPE DEF
SB_PIPE DEF
KA EI I I I I I I I I A A A A A A A A A A A AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAXhh Kk

<position name definition file>

<type of position name> <“the position name’> < > << >
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Pipe Modelling ( )

4 POSNAME_AUTO_TCODE

B R R T R R R S R R S R R S R R S R R S R R S R R R R R S S R S R R P R R R R R R R R R S R R S R R R R R R R R S R R S P R S S R P e

B

130

POSNAME_AUTO_SPOOL = ON (default) or OFF

POS AUT UPDATE
AUT REMOVE
ov OFF ov
ov
UPDATE POS AUT REMOVE

POSNAME_AUTO_PCOMP = ON (default) or OFF

POS AUT UPDATE
AUT REMOVE
ov OFF ov
ov
UPDATE POS AUT REMOVE

POSNAME_AUTO_TCODE = <type code> (no default)
POS AUT UPDATE

AUT REMOVE

130

POS

POS AUT

POS

POS AUT

POS
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Pipe Modelling ( )

POSNAME_SEQUENCE
4 ,
POSNAME_AUTO_TCODE POS AUT UPDATE
POS AUT REMOVE ;
POSNAME_SEQUENCE
4 , POSNAME_AUTO_TCODE
: POSNAME_SEQUENCE
4
E POSNAME_START = <start value> (no default)
POS AUT UPDATE

ASK_START

ASK_START

POSNAME_SEQUENCE

F POSNAME_INDICATE = <indicate value> (no default)

POS AUT UPDATE

BRANCH_START POS AUT UPDATE
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Pipe Modelling ( )

G POSNAME_PREFIX = <prefix> (no default)
POS AUT UPDATE

POS AUT UPDATE

H POSNAME_SUFFIX = <suffix> (no default)
POS AUT UPDATE

POS AUT UPDATE

I POSNAME_CHECK = PIPE (default) or MODULE
POS AUT UPDATE READY

CHECK

PIPE MODULE

MODULE

Pipe Production->Spool name->Update auto

2 POS AUT REMOVE

Pipe Production—->Spool name->Remove auto

3 Spool Information

Pipe Production—->Spool Info->Update
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Pipe Modelling ( )

Spool production information

TRIBON

TRIBON TRIBON
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Planning unit-------- :
Planning unrt
GCS
Heat treatm---------- :
Surf treatm---------- :
Initiate Outfitting(
) Pipe surface treatment

TRIBON

Test press----------- :

Sketch type---------- :

PRE prefabricated spool ------- s

TEMP  template spool ----------- s

PTE(prefabricated template spool):
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Prev spool----:

Next spool----:

Indicate spool

Pipe Production->Spool Info->Delete

Indicate spool

LA
0K to delete prod info ¥
Ho | lptions | Cancel |

Bt

Yes

x

@ Production data deleted!

Indicate spool
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Pipe Production—>Spool Info->Display

Indicate spool

Indicate spool

Spool limits

Pipe Production->Spool limits>Set

Indicate part( )

Indicate point

OE to continue (Yes or Hol?

Ho | lptions | Cancel |

Bt
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Indicate part( )

Pipe Production->Spool limits>Reset

Indicate part( )

Indicate point

OE to continue (Yes or Hol?

Ho | lptions | Cancel | Bt

Yes

Indicate part(

Pipe Production—->Spool limits>Display

x

@ Press Ok to continue!
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5 Part Information

Pipe Production—>Part Info->Update

Indicate part( )
B

Part information

R
ot tovse =]
[

TRIBON TRIBON
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Rotation---------——-
Acquisition code----
Joint prep code-----
Weld code-----------
Placing code--------
Loose keeping code--
MIS code------------
Insulation comp-----

Default insulation--

Component-----------
Part id---—--—-—————
Type of current part
Previous part-------

Next part-----------

Prev part----- :

Next part----- :
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Indicate part( )
x "
v
2
Pipe Production—>Part Info->Display
Indicate part( )
]
Exit
Indicate part( )
x "
v
e ek ek ek e ek ek ke ek ke ek ke e ek e e ek ek ke ek ke ek ok
11 GCS
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Sketch note

XX XX

56565

56567
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600mm R600
3
6-11
A MA
4
U1
5
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B*
W
2
Material note
6-12
A8
GCS
3 993
4 994
5 995
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997
995
999
2
6-13
G2
3 4 5 6 7 8 0
3
S
XX
565
4
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XX

G-1
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PRG

GCS TBGCS
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=T el 4

Lﬁﬁ}u‘txﬁv_ L, E%E'E Internet BFIEES
» Windows FAEITHE

HF @) =l

T R | e |

c:\tribon\m2\bin\sp304 DOS

Data bank name:

PIPE SB_PSDB
STRUCTURE SBF_DB_FSTRU
DRAWING SB_PDB
SKETCH SBP_SKETCH_DB
VOLUME SBD_VOLUME
PLACED VOLUME SBD_VOL_PLAC
DIAGRAM SB_VDIAGDB
SBD_VSDB

cnd
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STA

Objectname:

Forced unlock<Y/N>

Y

Objectname:

cnd

EXIT DOS
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Tribon
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68

69
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70

1589
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1589
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